
University of Maryland Baltimore County Thesis and Dissertation Style 

Guide 

This Electronic Thesis and Dissertation (ETD) Style Guide is intended to assist you in the 

preparation of your Master's Thesis or Doctoral Dissertation, in most cases the final requirement for 

your degree. The Graduate School at the University of Maryland, Baltimore County maintains 

specific requirements as to the format and appearance of its Theses and Dissertations; such 

requirements assure a standard of uniformity and aesthetic consistency commensurate with the 

rigorous academic principles of the University. In previous years, these formatting requirements 

were determined primarily by the restrictions associated the process of printing and binding the 

documents for publication. Theses and Dissertations completed in accredited Masters and Doctoral 

programs are published by ProQuest through an exclusive arrangement with the Library of 

Congress. These documents are also published electronically by ETD Digital Collections at AOK 

library, a free online archive of research done by members of the University community. 

The flexibility of electronic publishing fast becoming the standard for Theses and Dissertations 

enables the Graduate School to determine its own standards, independent of the printing process. 

This guide will assist you in creating a Thesis or Dissertation that conforms to those standards. 

Since January 2007, through an arrangement with ProQuest, the University of Maryland, Baltimore 

County has accepted Theses and Dissertations primarily in electronic format. Under this 

arrangement, students submit an electronic version of their Thesis or Dissertation (hereafter referred 

to as the Thesis) directly to ProQuest via the World Wide Web. Officials from UMBC will then 

review the document online and request revisions if necessary. This electronic process is the 

standard submission procedure for UMBC theses; the Graduate School will no longer accept 

hardcopy thesis or dissertation documents except in special circumstances at the discretion of the 

Dean of the Graduate School. Complete submission procedures are located under the "Submitting 

your document" section. 

 

  

http://gradschool.umbc.edu/
http://www.proquest.com/en-US/products/dissertations/
http://www.loc.gov/
http://www.loc.gov/
http://contentdm.ad.umbc.edu/
http://contentdm.ad.umbc.edu/
http://www.proquest.com/en-US/products/dissertations/


Before You Prepare Your Draft 
There are several steps that you need to go through before you begin formatting your dissertation. 

 

1. Take note of the published deadlines. These deadlines indicate the date by which your 

academically complete document must be submitted to the system. An academically 

complete document is one to which all examining committee-ordered revisions have been 

made. Any formatting changes requested by the Graduate School can be made after the ETD 

editors evaluate your document during the submission process. As long as your 

academically complete document is submitted by the deadline (even without correct 

Graduate School formatting), it is considered to have met the deadline. 

 

2. Understand the Formatting Requirements in this document, the UMBC ETD Style Guide. 

This Style Guide outlines all the formatting element that the Graduate School requires for 

your dissertation or thesis. Do not use a previously published University of Maryland, 

Baltimore County Dissertation or Thesis as a model. Format requirements may have 

changed, and the model may not be appropriate for your discipline or needs. Please note that 

the formatting requirements of the Graduate School supersede guidelines in any other style 

manual. You may wish to make use of the MS Word ETD Templates that the Graduate 

School has created. These documents are pre-formatted to Graduate School formatting 

standards. A LATEχ template is also available. 

 

3. Choose an appropriate Style Manual. The ETD Style Guide does not offer guidelines for 

formatting all elements of the document; it only outlines elements required by the Graduate 

School at the University of Maryland, Baltimore County. For all other elements, please 

default to the standard style manual in your discipline. To determine the preferred style 

manual in your discipline, consult your advisor or program. Refer to a style manual for 

systems of scholarly reference, setting off direct quotations, numbering figures and tables, 

presentation of data, and similar features. In general, it is advisable to become familiar with 

a professional style manual at this time in your academic career, if you have not already 

done so. Thus, a psychologist will use the APA (American Psychological Association) 

manual; a student of literature, the MLA (Modern Language Association) manual. Click 

here for a list of common academic style guides. 

 

4. Obtain Written Permission (If Needed) for Using Copyrighted Material. The U.S. Copyright 

Act of 1976 established the concept of "fair use" of copyright material in published work, 

but it does not provide absolute guidelines. Although ProQuest will publish your 

dissertation, ProQuest does NOT have the responsibility of seeking permissions for you. 

ProQuest uses The Chicago Manual of Style definition of “fair use.” You should become 

familiar with the concepts outlined there. Generally, the use of a complete unit (a poem, 

journal article, photograph, map, letter, and so on) requires permission. It is more difficult to 

define at what point a lengthy excerpt exceeds fair use. Good judgment will tell you that 

reproducing a significant proportion of another author's work is not "fair." However, be 

aware that "fair use" also touches on scholarly ethics or the use to which the quotation or 

excerpt will be put in your work. Another author's work should not be used as a substitute 

for your own analysis and argument. When in doubt, seek permission; it is usually granted. 

For a sample letter requesting reprint permission, please see Sample Letters and Pages. 

 

5. Obtain Permission for Use of Human or Animal Subjects. Prior to undertaking research 

using human or animal subjects, you will have had to seek and obtain approval. Be sure that 

the graduate program human subjects review board or university Institutional Review Board 

(http://www.umbc.edu/HARPO/) approval is indicated on the Nomination of Examining 



Committee form. If your research involves hazardous materials—biological or chemical 

agents or recombinant RNA/DNA—you must have approval from the appropriate university 

committee(s) and campus Department of Environmental Safety (call Timothy A. Sparklin at 

410-455-2737, or located online at the following URL: http://www.umbc.edu/safety/. 

 

6. Investigate Possible Patent and Public Disclosure Issues. A significant number of invention 

disclosures submitted by graduate students are related to materials contained within that 

student's thesis or dissertation. If your thesis or dissertation describes a new technology, any 

publication (digital or otherwise), presentation, or public posting—such as submission to 

ProQuest Learning Services / Digital Dissertations, or the Albin O. Kuhn Library —may be 

considered a “public disclosure” of the invention. If such public disclosure is made prior to 

applying for a patent, certain patent and intellectual property rights may be compromised. 

 

It is the responsibility of the author of a work submitted to the Electronic Thesis and Dissertation 

Program at UMBC to notify the Office of Technology Development of such submission if the work 

has been, or will be, submitted in part or in its entirety as an invention disclosure. Note: Posting 

may compromise certain patent rights. 

The Office of Technology Development can be reached via its website: http://www.umbc.edu/otd/, 

or at the following addresses: 

Office of Technology Development 

University of Maryland, Baltimore County 

bwtech@UMBC 

5523 Research Park Drive, Suite 310 

Baltimore, Maryland 21288 

410-455-1414 (Phone) 

410-455-8750 (Fax) 

  

Preparing Your Draft 
Since the University of Maryland, Baltimore County is now accepting Theses and Dissertations 

primarily in electronic format, this Style Guide is focused on assisting your preparation of an 

electronic file that conforms to the standards set by the Graduate School. This electronic file will be 

submitted directly to ProQuest Information and Learning via the World Wide Web and evaluated 

by the Graduate School online. 

 

Basic Requirements 

The final electronic file that you submit to ProQuest and The Graduate School must meet the 

following conditions.  

 Be submitted in PDF format. Conversion utilities for Microsoft Word (.doc) and Rich Text 

Format (.rtf) documents are available. 

 Be in an approved font. The Graduate School strongly recommends Times New Roman 12. 

 Have acceptable margins, line spacing, page numbering, and page layout. 

 Contain all required Formal Elements of the Thesis / Dissertation. 

 

The Graduate School has developed a number of Thesis and Dissertation templates for users of MS 

Word. These templates can serve as a guide for students creating an acceptable Thesis or 

Dissertation document, and are available here. “Lite” or simplified versions of the templates are 

also available for documents with few chapter sub-sections. 

 

File Format 



ProQuest requires that the final Thesis document is submitted in Adobe Portable Document Format 

(PDF). Microsoft Word (.doc) and Rich Text Format (.rtf) files are easily convertible to PDF 

documents using conversion utilities on the ProQuest thesis submission site. Conversion programs 

other than the ProQuest conversion tool are strongly discouraged due to pagination problems. 

Microsoft software, including Microsoft Word, is widely available, and is present on most UMBC-

owned computers. Most commercially available word processing software packages, including 

WordPerfect (versions 6.0 and above) have the capability to save in Rich Text Format (.rtf); this is 

a text-based format that allows for the use of features such as bolding, italics, and underline. 

LATEχ and other technical software packages often have PDF creation utilities bundled with them 

or available as an add-in. The PDF document that ProQuest receives is the document that will be 

published; take appropriate steps to ensure that the PDF you submit accurately reflects your work. 

 

No matter what method you choose for preparing your draft, BACK UP YOUR WORK ON AT 

LEAST TWO DIFFERENT STORAGE DEVICES and keep those devices in safe places.  

 

Font / Type Style 
The same font should be used throughout the Thesis, for text, headings, captions, labels, and 

references; the Graduate School strongly recommends using Times New Roman 12, a widely 

accessible standard font that will minimize software and reader compatibility problems. Tables, 

captions, and footnotes should use the same font face, but can be in a smaller size. Font sizes 

smaller than 10, however, tend to be difficult to read in print and PDF format. You may create 

chapter and section headings that are two or three points larger than your standard typeface at your 

discretion. 

While the Graduate School strongly recommends Times New Roman 12, some other fonts are 

acceptable as well. Fonts that will definitely be approved by the Graduate School: 

• Arial 12 

• Bookman 12 

• Times New Roman 12 

• Times New Roman 14 
 

LATEχ Users: The Computer Modern fonts in LATEχ are in most cases an acceptable substitute for 

the above fonts. Please keep in mind, however, that other defaults, including margins and headings 

in technical software such as LATEχ may not conform to Graduate School standards. 

For symbols, use Symbol 12 or a symbol font compatible with your base font. Most word 

processors include basic character fonts. 

Instructions for altering the font of your document in Word are available here. 

 

Margins 
Each page must have at least a 1.5" left-hand margin, and at least 1" top, bottom, and right margins. 

Most word-processing packages provide a style or template that will set these automatically for 

your document. Margins may be wider but not narrower than these standards. Please note that all 

pages must meet these requirements, including the Title Page, illustrations, tables, appendices, and 

curriculum vitae. 

Instructions on setting the margins of your document in Word are available here. 

 

Justification 
Type may be left justified, which leaves a “ragged right” margin (as is used in this manual), or may 

be full-justified, which establishes even margins on the left and right. You may wish to consult with 

your department as to the standards in your discipline. 

Instructions on setting the justification of your document in Word are available here. 



 

Line Spacing 
Each page must be double-spaced, with the following exceptions: 

 Front matter such as the title page, table of contents, lists of tables and figures may be 

single-spaced. 

 Tables within the text may be single-spaced. 

 Extended citations within the text may be set off and single-spaced. Consult your style 

manual for details. 

 Definitions within glossaries or questions within surveys may be single-spaced, but double-

spaced between entries. Scholarly references--footnotes, endnotes, bibliography or list of 

references--may be single-spaced, but double-spaced between entries. 

 

Page Number Placement 
Page numbers must be placed either at the bottom center, bottom right, or the top right of each 

page. If you choose the top right, you may place the page number at the bottom center when 

beginning a new chapter. Otherwise, maintain a consistent placement throughout your manuscript. 

Instructions on formatting page numbers in Word are available here. 

 

Widows and Orphans 
A “widow” is a short line or single word ending a paragraph at the top of the next page. An 

“orphan” is a heading or subheading that appears at the bottom of a page with the text beginning on 

the following page. These are not desirable for reasons of aesthetics and readability, and they are 

prohibited. Word processing software can be set to avoid both “widows” and “orphans” 

automatically. 

 

Chapters 
Begin each chapter on a new page, except for APA format, and number the pages consecutively. Do 

not use a secondary page numbering system for sections within chapters. 

 

The Formal Elements: Abstract, Title Page, Lists, Tables, and Appendices 
The formal elements are described below. The Abstract, Title Page, Copyright Page, and Table 

of Contents must to be formatted in the method described; other pages, as long as they adhere to 

the previously stipulated requirements (font, margins, justification, etc.) may be designed as the 

author deems appropriate. 

 

Below is the required order of the formal elements of the dissertation: 

1. Blank page (must be first, required, non-numbered) 

2. Approval sheet (required, non-numbered) 

3. Curriculum Vitae (required, non-numbered) 

4. Abstract (required, non-numbered) 

5. Title page (must follow Abstract, required, non-numbered) 

6. Copyright statement (highly recommended, non-numbered) 

7. Blank page (required, non-numbered) 

8. Preface or Foreword (if present, start at lower-case Roman numeral ii) 

9. Dedication (if present, lower-case Roman) 

10. Acknowledgements (if present, lower-case Roman) 

11. Table of Contents (required, lower-case Roman) 

12. List of Tables (lower-case Roman) 

13. List of Figures (lower-case Roman) 



14. List of Abbreviations (if present, lower-case Roman) 

15. Body of Text (required, start at Arabic numeral 1) 

16. Appendices (if any, Arabic) 

17. Glossary (if any, Arabic) 

18. References or Bibliography (required, Arabic) 

19. Index (if any, Arabic) 

20. Blank page (required, non-numbered) 

 

 

Front Matter: 
Approval sheet 

(Required; not numbered). The signature page must be filled out appropriately. 

 

Curriculum Vitae (C.V.) 

(Required; not numbered). Inclusion of your academic curriculum vitae is required. Please note that 

it follows the approval sheet and is not numbered. It must have the same page layout as the rest of 

the dissertation, including margins. 

 

Abstract 

(Required; not numbered; double-spaced). Your abstract provides a summary of the thesis / 

dissertation. Its purpose is to convey the essence of your work to those who may not wish to read 

the entire document. Abstracts include a statement of the problem, a summary of methods or 

procedures, the results, and the conclusions. 

Abstracts for the master's thesis or doctoral dissertation must not exceed two pages. Dissertations or 

theses are required to be in English. 

 

Title Page 

(Required; not numbered). The title page MUST include the following information: 

 the full title of your thesis / dissertation 

 your name as it appears in university records 

 the year of the degree (not month or day) 

 a standardized degree statement typed in inverted pyramid form (given below) 

 

Word your title very carefully. Electronic databases, citation indices, and bibliographies search 

using key words, so choose terms carefully to reflect accurately the content of your thesis / 

dissertation. Be sure that the title is exactly the same on the abstract and title page.  

 

The title page must not include italics, unless foreign words or botanical terms form part of the title 

itself. Do not use abbreviations. Formulas, symbols, superscripts, Greek letters or chemical names 

must be expressed as words wherever this is possible and consistent with disciplinary standards. 

 

Standard Degree Statement. Use the following wording, inserting the correct degree title and the 

year (only the year) of your graduation, and typing in inverted pyramid style: 

Thesis [or Dissertation] submitted to the Faculty of the Graduate School of the 

University of Maryland, Baltimore County in partial fulfillment 

of the requirements for the degree of 

[complete degree title] 

[year of graduation] 

There is a title page format sample here that is acceptable for both the master's thesis and doctoral 

dissertation. 

  



Copyright Page 

(Highly Suggested; not numbered). Both master's degree and doctoral candidates may register their 

copyright on theses or dissertations. This can be done through the electronic submission process 

(via ProQuest) or through the Library of Congress. Follow the directions on the ProQuest website 

when you submit your document to have ProQuest register copyright on your behalf, or visit 

http://www.loc.gov for information on registering directly with the Library of Congress. 

 

Preface or Foreword/Dedication/Acknowledgements 

(Optional; if used, begin numbering using lower-case Roman numeral ii). All, some or none of 

these elements may be included. Many theses do not include any of these elements. Check your 

style manual for the preferred order in your discipline. 

 

According to The Chicago Manual of Style, a Foreword includes a statement about the work by 

someone other than the principal author. A Preface contains the author's own statement about a 

work, sometimes including acknowledgments and permissions. If all you want to do is 

acknowledge others' assistance and support, then label the page "Acknowledgements," not 

"Preface." Acknowledgements are made for special assistance or unusual permissions granted. You 

may wish to dedicate the work to a special mentor, but avoid elaborate or fulsome language. 

 

Table of Contents 

(Required; if no optional elements precede, begin numbering with lower-case Roman numeral ii; 

otherwise, continue in sequence using lower-case Roman numeral).  

 

A table of contents is required in all theses. Most word processing software allows you to mark 

each chapter heading and subsection in the text and then generate a table of contents automatically 

with correct page numbers retained.  

 

You may single-space between chapter subheadings, but be sure to double-space between chapters 

or major sections. You may choose to use dot leaders or not, as you wish. Most software-generated 

tables of contents would be acceptable. 

 

Please note that the numbering of the entries in the table of contents must be absolutely consistent 

with any numbering system used in the text. Thus, if you number subheadings within Chapter 1 as 

1.1, 1.2, and so on, this same numbering must be used in the table of contents. You need not 

number or label subheadings, however. At the end of this chapter there is an example of the table of 

contents that is valid for both the master's thesis and doctoral dissertation. 

 

List of Figures/List of Tables/List of Abbreviations 

(Optional; number consecutively following the table of contents using lower-case Roman 

numerals). If you have at least one figure or one table, or more than one page of abbreviations, you 

must include the appropriate list.  

 

A table includes written material or data, whereas a figure refers to non-textual illustrative material. 

The easiest way to generate these lists is to create a secondary table of contents if your word 

processor permits. Unless your Style Guide directs otherwise, use the table and figure captions from 

your text to identify these in the list. Be sure all captions and numbering correspond exactly to 

those within the text. Check your style manual for the preferred order in your discipline. Remember 

to keep the required 1.5” left hand margin. 

Body 

(Begin page numbering with Arabic numeral 1 and number all subsequent pages consecutively to 

the end.) The body of the thesis / dissertation should be typed continuously (except if your word 



processor is set to avoid “widows” and “orphans”), double-spaced, with each new chapter 

beginning on a fresh page. The chapter title may be typed no more than 3" from the top of the page, 

and may be typed in a font not more than two or three points larger than the base font. However, 

you need not place the chapter heading lower on the page or use a larger font, if you prefer. 

 

Illustrations and Non-Text Elements 

In this Guide, the term "illustration" is meant to cover all non-text elements of the thesis / 

dissertation, such as figures, tables, maps, plates, photographs, drawings, and so on. Each 

illustration must be numbered consecutively. Consult your style manual for a consistent numbering 

and identification system. Illustrations must be listed by category in the preliminary pages. All 

illustrations must conform to the minimum margin formats. If illustrations are larger, then use 

photographic reduction to achieve an appropriate size. However, figure captions should be 

consistent with the body of the thesis / dissertation text—these, like footnotes, can be 2 points 

smaller than the text, but no smaller than 10 point. 

 

Illustrations should be placed in the text as close to the first mention of the figure or table as 

possible--either on the same or on the following page, but never before the first reference. In some 

cases, tables and figures can be assembled in an Appendix. 

 

If you have any questions or concerns about incorporating illustrative materials into your thesis/ 

dissertation, please consult with the staff of the Graduate School for guidance before you begin to 

prepare the final manuscript. 

 

Captions 

All illustrations must be identified by captions, preferably on the same page. If a figure or table is 

too large or the caption too long for both to fit on the same page, the caption should appear on the 

preceding page. 

 

Images / Photographs 

Since Theses and Dissertations are accepted only electronically, all images, photographs, plates, 

and illustrations should be included in the electronic file, via scanning or other method of 

reproduction. Most word processing programs (MS Word, WordPerfect) have a feature that enables 

one to embed objects, such as images, into the text. For information on including copyrighted 

images in your work, please see Submitting Your Thesis or Dissertation. 

 

Other Materials 

Some few theses will include video or audio tapes; films or slides, or computer or compact discs. 

These materials should be converted into digital format (MP3 or WMA for audio files, MPEG, AVI 

or QuickTime for video files) for submission to ProQuest through the electronic submission 

process. If these materials cannot be submitted electronically, 2 copies of each should be submitted 

in hard copy to the Graduate School. Attach a copy of your Abstract page and Title page to any 

materials you submit. For more information, please see Submitting Your Thesis or Dissertation. 

 

BACK MATTER 
Appendices 

(Optional; pages numbered consecutively with the text). Follow the recommendations in your 

chosen style manual for materials appropriately presented in an Appendix rather than in the body of 

the text. You may have multiple appendices, which must be labeled consecutively (A, B, C, etc. or 

I, II, II, etc., as appropriate to your discipline). Be sure to include all appendices in your table of 

contents.  

 



An original survey instrument prepared in a typeface different from that of the thesis / dissertation 

is acceptable. 

 

If used, scanned supporting materials reproduced from other sources (with permission) must meet 

the same requirements for margins and clarity as the rest of the dissertation. Copies from books, 

journals, maps, and so on must be completely clean and legible. Residual shadows from page edges, 

as may be created in the process of scanning, are not acceptable. 

 

Glossary 

(Optional; pages numbered consecutively with the text). Please note that the Graduate School 

requires the glossary to be placed at the end of document, prior to the list of scholarly references. 

Definitions may be single-spaced, but double-space before beginning a new one. 

 

Scholarly References 

(Required; pages numbered consecutively with the text). 

Footnotes and Endnotes: Whether you choose to place footnotes for each chapter at the bottom of 

the page, gather notes for each chapter at the end of the chapter, gather all notes at the end of the 

dissertation, or use inter-textual parenthetical notes with a list of references at the end, be sure that 

placement and style are consistent throughout. Do not place some notes at the bottom of the page, 

and gather others at the end of chapters. Do not use both parenthetical notes and citation footnotes 

(explanatory footnotes are acceptable). Prepare a sample page featuring your notes early in the 

typing process, to check that the font, margins and spacing conform with the formats required. Note 

that some word processing software will use the default initial font for footnotes, so check your 

document style to be sure that footnotes appear in the standard font you have chosen. 

 

List of References: Each UMBC Thesis or Dissertation must have a comprehensive list of 

references included in it, even if such references are already included in footnotes or endnotes.  

 

Your List of References (References) or Bibliography must be placed at the end of the thesis / 

dissertation, or after each chapter. Follow what your chosen style manual recommends. 

 

Index 

If your thesis / dissertation features an index, place it after the reference page. Follow the format 

described above for optional formal elements.  

  

  



Formatting Your Document With Ms Word 
This chapter is intended as a resource to assist you in formatting your document with Microsoft 

Word.  In this section, we address many of the technical problems students have with formatting 

their document; these include setting fonts, margins, and justification, as well as the (at times 

counter intuitive) method for using multiple page numbering schemes within a single 

document. 

 

Margins 
The Graduate School requires that each page of the thesis or dissertation must have 1.5" left and 

and 1" right, top and bottom margins.   To set the margins of your Word document: Choose 

Page Layout<Margins< Custom Margins: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Set margins as: 1.5" left and 1" right, top and bottom margins. 

 



Font 

To change your font in Word: 

1. Select the text that you want to change. If you want to change the entire document, click Edit 

and then Select All. 

2. Go to the formatting toolbar at the top of the Word screen. It should look something like this: 

 
 

3. You should see the default font of the document in the toolbar window (usually Times New 

Roman). Click on the down arrow to see the list of Word fonts available. 

4. Click on the font you wish your text to change to. 

 

Justification 
Thesis and dissertation text may be left-justified, which leaves a “ragged-right” margin (as in this 

document), or text may be full justified, which creates even margins on the left and right sides of 

the page.   To change the justification of your document: 

 

The button is for LEFT justification.  The      button is for FULL justification, even margins 

on both sides.  The button is for CENTER justification, where the text is centered on the page. 

 

 

 

 

 

 

 

 

 

 

Page Numbering in MS Word 
This is often the most infuriating part of formatting a theses or dissertations.  The Graduate 

School requires three different page numbering schemes in each thesis/dissertation: 

 No Page Numbers:  CV, Abstract, Title Page, and Copyright Page 

 Lower-Case Roman Numerals (iii, iv, v, vi, viii):  Front Matter  (Preface, Foreword, 

Acknowledgements, Table of Contents, List of Tables, List of Figures, List of 

Abbreviations) 

 Arabic Numerals (1,2,3,4):  Main Body Text, Appendices, Glossary, References, Index 

 

 

 

 

 

 

 

 

Document Sections 



In Word, page numbers are properties of document subdivisions, called sections. One Word file (a 

single document) can have an unlimited number of sections; as a document author, you control how 

your document is subdivided into sections by inserting section breaks. 

 

Each section of your document can have different properties: layout and orientation (columns, portrait / 

landscape), borders and line spacing, and of course page numbering. 

 

For a University of Maryland, Baltimore County thesis done in MS Word, you'll need 3 different page 

numbering schemes; as such, you will need to divide your document into three sections. 

 

Inserting section breaks, dividers between sections, is easy. Word documents by default contain only 1 

section. We will be inserting 2 breaks to divide the document into 3 sections, each of which will have a 

different page numbering scheme. We'll first divide the document into sections, and then insert the page 

numbers. 

 

First Section Break: After Signature page, Cirriculum Vitae, Abstract, Title Page, and Copyright page, 

before Front Matter. Place your cursor at the very bottom of your Copyright page (about 9 down). Then 

click Insert on the menu bar: 

 

Please follow the detailed instructions on the subsequent pages. 

 

Inserting Page Numbers      [For MS Word2010] 

 

I.      You may find it useful to Show Paragraph Marks, by clicking the paragraph symbol (¶) in the 

Paragraph dialog box. 

 

 

 

 

 

 

 

II.     REMOVE ALL PAGE NUMBERS FROM THE DOCUMENT 

A.  Click the Insert tab. 

B.  Click “Page Number.” 

C.  Click “Remove Page Numbers.” 

 

A                                                                             
B 

 

 

 

 

 

 

 

 

 

 

 

 

 



III.    CREATE SECTIONS 

A.  Place cursor at the last line of text on what will be the last un-numbered page (typically 

the Copyright page). 

B.  Click the Page Layout tab. 

C.  Click “Breaks.” 

D.  Click “Continuous.” 

 

B 

C 

 

 

 

E.  Place the cursor at the bottom of the last page that should have lower case Roman 

numerals. 

F.  Insert another Continuous Section Break, as described in steps C and D above. 

 

IV.   INSERT PAGE NUMBERS 

A.  Go to the first page of your document. 

B.  Click the insert tab. 

C.  In the Header & Footer group, click “Page Number.” 

D.  Click “Bottom of Page.” 

E.  Select the option with the page number in the bottom center of the page. 

F.  You should see Arabic numbers throughout your document. 

 

B 

C 

 

 

D 

 

 

 

 

E



V.     UN-LINK SECTIONS 

A.  With the Header/Footer visible, click in the footer of the first page of section 2 (first 

page that requires lowercase Roman numerals). 

B.  In the Navigation group, un-click “Link to Previous.” 

C.  Repeat steps A and B in the first page of body. 

 

 

 

 

 

B 

 

VI.   FORMAT PAGE NUMBERS 

A.  Go to the first page of your document (first page of CV). 

1.   In the footer, delete the page number using the delete or backspace key. 

2.   You should see no Page numbers in the first section. 

B.  Go to the first page of section 2 (first page that requires lowercase Roman numerals). 

1.   Click in the footer. 

2.   In the Header & Footer group, click “Page Number.” 

3.   Click “Format Page Numbers….” A dialog box will appear. 

4.   Change the Number Format to i, ii, iii, …. 

5.   Click “Start at” and select iii. 

 

 

 

4 

 

 

 

 

 

 

 

 

 

5 

 

 

 

 

6.   Click OK. 

7.   Section 2 should begin with iii.  (Note:  If using iii does not work, repeat step 5 

using ii.) 

C.  Go to the first page of section 3 (first page of the body). 

1.   Click in the footer 

2.   In the Header & Footer group, click “Page Number” 

3.   Click “Format Page Numbers….” A dialog box will appear. 

4.   Change the number format to 1, 2, 3…. 

5.   Click “Start at” and select 1. 

6.   Click OK. 



7.   You should see that section 3 begins with 1. 

D.  Save your changes.



Inserting a Table of Contents                      [For MS Word 2010] 

 

I.      CREATE BOOKMARKS FROM HEADINGS 

A.  Click the View Tab. 

B.  In the Document Views group, click “Outline.”  A new screen layout and new options 

will display. 

B                                                                   A 

 

 

 

 

 

C.  Using the mouse, select the text of the first chapter heading. 

D.  Hold down the Control key and select the next chapter heading using the mouse. 

E.  Repeat until you have selected all chapter headings.  (If you prefer, you may work on 

each heading individually.) 

F.  Select “Level 1” from the Outlining drop-down box at the top left. 
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- The text color/size/style/will change. 

 



G.  Repeat steps C through E to assign chapter sub-sections to Level 2, as appropriate. 

These subheadings will be indented and the font formatting will change. 

 

 
 

H.  Click the Home Tab to view the font dialog box. 

 

H 

 

 

 

 

I 

 

I. Change the font, font:  size, style, and/or color to be consistent with the rest of your 

thesis/dissertation and to be in accordance with Style Guide requirements. 

 

II.     INSERT A TABLE OF ONTENTS 

 

A.  Click the View Tab. 

B.  Click “Print Layout.”  Your screen layout will revert to normal. 

B                                                                  A 

 

 

 

 

 

C.  Place the cursor where the Table of Contents should appear in the document. D.  

Type the heading “Table of Contents” at the top of this page. 

E.  Click the References tab 

 

E 

 

 

 



F.  Click “Table of Contents” 

G.  Select “Insert Table of Contents” near the bottom of the drop-down list. 
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H.  Several options will display.  Ensure that the following options are selected: 

- Show page numbers 

- Tab leader (...). 

I.   Click “OK.” 

J.   Save your changes. 

 

 

 

 

 

H 

 

 

 

 

 

 

 

 

~ You will see the Chapter Headings, dot leader, and page numbers appear on the Table 

of Contents page(s).



Note:  If you make changes to your document (e.g., change chapter headings, add/delete a 

chapter or section, move illustrations) after inserting the Table of Contents, you will need 

to... 

 

III.   UPDATE THE TABLE OF CONTENTS 

A.  On the References Tab, in the Table of Contents group, click “Update Table.” 

B.  Click “Update entire table” to include all changes to page numbers and/or 

headings. C.  Click “OK.” 

D.  Save your changes. 
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~ Whenever you change your document, you need to repeat steps A through D in order 

to incorporate new headings and page numbers into the table of contents. 

 

Inserting Dot Leaders (.…)  [For MS Word 2010] 

1.   Select text on the Table of Contents/List of Tables/List of Figures 

2.   Click the ruler to create a tab stop. 

3.   Click Page Layout 

4.   Open the Paragraph dialog box and click Tabs at the bottom 

5.   Under Leader, click option 2. 

6.   Click Set. 

7.   Click OK. 



8.   Place cursor after the first chapter/table/figure name and press tab.  Dot leaders 

should appear. 

9.   Repeat step 8 for each remaining chapter/table/figure name. 

~   To insert dot leaders in other Lists, repeat the above steps on selected page(s) 


